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LE S SON  2  

FLYERS 
 

OBJECTIVES 

Upon completion of this lesson, you should be able to: 

� Search the Clip Organizer for desired clip art. 

� Search Clip Art on Office Online for desired clip art. 

� Add clip art to a publication. 

� Move and resize a clip art frame. 

� Rotate and flip a clip art frame. 

� Use the Character Spacing feature to format text. 

� Use the Measurements toolbar to size text. 

� Use the ruler guides to position a frame. 

� Add and format a WordArt frame. 

�Change the bullet symbol. 

� Layer and group objects. 

� Wrap text around a clip art frame and WordArt frame. 

ESTIMATED TIME: 6 HOURS 

What Is a Flyer? 

A flyer is a publication that announces an event or advertises a special limited-time 
promotion of a single product or service. It is printed on one side of a single sheet of paper and 
is usually hung on walls or bulletin boards, placed on counter tops, or inserted into newspapers 
or shopping bags. It is used to generate interest an organization or event. 

Design Considerations for a Flyer 

To be effective, a flyer must include the following objects: 

� A large headline that can be read at a distance 

� Minimum body copy 

� Some graphic objects or attention-getting visuals 

� Description of the product or event 

� Price information (if applicable) 

� Company or organization name prominently placed 

� Company address, phone and fax number positioned near the company logo or name 
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Other suggestions for design include the following: 

� Use font styles that represent the product advertised. Use enough contrast between the 
headline and text to make the headline stand out. 

� Make the information brief and easy to read. 

� Use a single, dominant color that is easy to read if it is used as text color or background fill 
for text box frames. 

� Choose an appropriate paper color. 

� Consider larger-sized paper such as 11 x 17. 

� Make sure the page is not cluttered with excess text and graphic objects. 

The Lesson Project 

For this lesson, you will begin by creating a flyer for the 
City of Otter Creek that will promote the wearing of helmets 
when riding bikes (Figure 2-1). 

Using the Clip Organizer 

In the previous lesson you learned how to add a picture 
to a document using the Picture frame. In this lesson, you will 
learn how to use the Clip Organizer. The Microsoft Clip 
Organizer, included with Microsoft Office XP, is a stand-
alone program that is used to organize media clips for Office 
documents. The Clip Organizer also comes with a variety of 
media clips for your use. 

HOW CLIPS ARE ORGANIZED 

When Clip Organizer is first used after it has been 
installed, it scans your computer for media files and organizes 
media clip shortcuts into collections (folders). When you are 
in the Clip Organizer, you can preview, open, or insert a media file into your document without 
having to go to the actual storage location on your computer. The clips are organized into three 
types of collections: 

� My Collections, which include clips you have stored on your hard disk. 

� Office Collections, which are clips that come with Microsoft Office XP as well as clips on 
the Clip Organizer CD. 

� Web collections, which is a link to an online source provided by Microsoft content 
partners.  

To insert a clip art object, click the Picture Frame on the Object toolbar and choose Clip 
Art task from the drop-down menu. The Clip Art pane will appear at the left side of your 
screen. This task pane is illustrated in Figure 2-2. 

Search for a clip by keying in the Search text box a word or phrase that describes the clip 
you want. You can limit where you want the search carried out by specifying the collection to 
be searched in the Search in drop down list. You can limit the type of media to be searched in 
the Results should be drop down list. The choices for types of media include the following: 

FIGURE 2-1 

Bike Helmet Flyer 
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� All media file types 

� Clip Art 

� Photographs 

� Movies 

� Sounds 

When the specifications have been entered 
or chosen, click Search to see the results. The 
results of the search will be shown in the same 
pane as thumbnail (very small) images. Figure 
2-3 shows the possible results of a search for 
helmet. You can scroll down to see additional 
images. 

ADDING A CLIP TO YOUR DOCUMENT 

Once you have found a clip you like, you 
may either click it to select it or drag it onto 
your open document. If you want to add 
several clips, hold the CTRL key down as you 
select additional clips and drag them all at once 
into your document. (If you do this, the clips 
end up stacked on top of each other, and you 
need to move them off the pile and into the 
document one by one.) 

Exercise 2.1 

1. Start Publisher. Go to a new blank page, 

choosing the Letter (portrait) 8.5 x 11” size 

page. 

2. Click the X in the upper right corner of the task pane to close it. 

3. Click the Insert menu and choose Picture and then Clip Art. 

4. Click Yes if a “Do you want to use . . . . “ message appears. 

5. Key helmet in the Search text box and click Go. Look at the results.  

6. Delete helmet and key bikes in the Search text box. Click Go. 

7. Scroll, if necessary, to find an image that contains a bike rider wearing a helmet that looks like a 

young person. (You may not find the image shown in Figure 2-1.) 

8. Drag the image onto your document and release the left mouse button anywhere in the 

document. 

9. Save the publication as bike helmets xxx (where xxx are your initials). Keep the publication open 

and read on. 

FIGURE 2-3 

Results of Search in Clip 
FIGURE 2-2 

Insert Clip Art Task Pane 
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ADDITIONAL CLIP OPTIONS 

A gray bar with an arrow appears beside the selected clip in the Clip Art task pane. When 
you click the arrow, Publisher displays a menu of choices that relate to what can be done with 
that clip (see Figure 2-4). These choices include the following: 

� Insert—Insert the clip into the document. 

� Copy—Puts a copy of the selected clip into the Office Clipboard. 

� Delete from Clip Organizer—Deletes the shortcut to the clip 
that is showing in the Clip Organizer. It does not delete the actual 
stored file. 

� Make Available Offline—Makes the selected image available 
when you are not connected to the Internet.  

� Move to Collection—Move a selected image to another 
collection or create a new collection to which the image can be 
moved. 

� Edit Keywords—Keywords are stored with the image that 
describes the image. These help when searching for clips. This 
option lets you add, edit, or delete keywords. This can only be 
done on your personal collections. Keywords can also be changed 
in the Properties dialog box. 

� Find Similar Style—This will bring up other images created in 
the same artistic style but not necessarily matching the keyword.  

� Preview/Properties—This dialog box shows the properties of 
the image such as the type of file, size, and properties. 

Exercise 2.2 

1. Click on the down arrow next to any image in the Insert Clip Art task pane. Click the Insert 
command. Did the image appear in the document page? 

2. Close the Clip Art task pane by clicking the X in the upper right corner of the pane. You’ll learn 
to redisplay it shortly. 

3. Save the publication and keep it open as you read on. 

Viewing Clips by Collections 

At the bottom of the Clip Art task pane is the Organize Clips . . command. Clicking on 
this command will result in the opening of the Microsoft Clip Organizer. Once you're in Clip 
Organizer, you can search for clips or browse the collections.  

When you choose Organize Clips . . ., Publisher may ask if you would like to sort your 
clips now or later. For classroom purposes, we will choose Later. This takes you to the 
Organize Clips dialog box.  

There are two different views in the Clip Organizer. One is by Search, as illustrated in 
Figure 2-5. This is similar to the Clip Art task pane. You can key keywords into the Search text 
box and click Search. You can also limit the search to certain collections and types of media 
files as you did in the Clip Art task pane. 

FIGURE 2-4 

Drop-Down List for a Clip 
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The other view is by Collection Lists. 
The collections have a plus or minus to the 
left of the collection name. A plus indicates 
subfolders. Clicking the plus will expand the 
main collection folder and list the subfolders. 
Some subfolders also contain folders. A 
minus indicates that the main folder (or 
collection) is expanded. You should see 
subfolders listed under the main folder name. 
In this view you can choose a collection as 
well as a folder in that collection and simply 
browse through the images until you see one 
you like. These would be very broad 
categories. In Figure 2-6 the Office 
Collection is selected and the Animal folder 
is selected. 

Notice that in the lower right corner of 
some of the thumbnail images are little icons 
that tell you where the clip is located or if it 
is an animated gif.  

Exercise 2.3 

1. If the task pane is closed, select Task Pane from the 
View menu. 

2. Change the task to Clip Art from the down-
pointed triangle next to the X at the top of 

the Task Pane. 

3. Click Organize clips . . . at the bottom of 
the Clip Art task pane. 

4. Click Later if you are asked if you wish to 
organize your clips.  

5. Click Search at the top of the Clip 
Organizer. 

6. Key bikes in the Search text box and click 
Go. 

7. Find another bike image in which the biker is 

wearing a helmet. Drag the image, using 

your left mouse button, anywhere onto the 

document page.  

8. When you dragged the image, the Clip Organizer dialog box was minimized. Click the Clip 

Organizer button on the Taskbar at the bottom of the screen to restore it. 

9. Click Collection List at the top of the left pane of the Clip Organizer. 

FIGURE 2-5 

Clip Organizer Viewed by Search 

FIGURE 2-6 

Clip Organizer Viewed by Collections 
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10. Click the Office Collections folder. Click the + to expand the folder, if necessary. 

11. Scroll down to the Sports subfolder. Click on the + to expand the Sports subfolder.  

12. Click on the Equipment subfolder. 

13. Drag any image that you find there anywhere onto the document page. The Clip Organizer will 

be minimized again. 

Using Help in the Clip Organizer 

Because Help may be a new feature for you, we’ll learn to use the Help feature in the Clip 
Organizer dialog box. Help is a separate program within the Office Suite. You will see an Ask a 
Question text box in the upper right corner of the Clip Organizer. Key a question in that box 
and press Enter. You will get a bulleted list of possible answers. Clicking a bulleted item will 
open a help pane with instructions or information related to your bulleted 
choice (see Figure 2-7).  

At the top of the Help pane, next to your question, 
is a search button that gives you some choices about 
where you want Microsoft to search for answers to your 
question. Figure 2-8 illustrates that you can get help 
from a number of sources. 

Exercise 2.4 

1. Click the button on the Taskbar to restore the Clip 
Organizer. Click in the Type a question for help box 

located in the upper right corner of the dialog box and 

key how do I copy an image. Press Enter. 

2. Scroll down and click the bulleted item that reads 

What uses of photos, clip art . . .  

3. Read the results in the Clip Organizer Help pane. 

Then click the left-pointing arrow at the top of the 

Help pane to return to the original list of answers to 

your question. 

4. Click  the down-pointing arrow beside the word 

Search near the top of the Clip Organizer Help pane.  

5. Close all Help panes, keeping only the Clip Art task pane showing 

at the left of the window.  

 

Using Clips Online 

Below the Clip Organizer link at the bottom of the Insert Clip Art task pane is the Clip art 
on Office Online command. This link takes you to the Clip Art and Media portion of Microsoft 
Office Online. A portion of that Web page is illustrated in Figure 2-9. You have to be connected 

FIGURE 2-7 

Clip Organizer Help 

FIGURE 2-8 

A Search Pane 
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to the Internet for this feature to work. (NOTE: This Web site changes frequently, so it may not 
look exactly like Figure 2-9.) 

At the top of the window are options for keying a keyword and where to search. The 
number of pages of images available will show in the upper and lower right corners. The 
example showing in Figure 2-10 is page 26 of 39. To move from page to page, click the arrow 
or select a page number from the drop-down list next to the current page number. 

As you move from page 
to page, if you see any 
images you like, click in the 
option box under the image 
to insert a checkmark. The 
checked images are the ones 
that will be downloaded to a 
collection folder on your 
computer. You can deselect 
an unwanted image by 
clicking it again. The check 
mark will disappear. 

When you are done 
making your selection(s), 
click the Download # clips 
which is at the left, above the 
first row of images. You will 
see the window in Figure 2-
11. This window indicates 
how many clips are selected, 
their total size, and the 
approximate time it will take 
for them to download from 
Internet to your computer.  

In the Opening ClipArt 
dialog box, you will click 
Save to Disk and OK. The 
images you selected in the 
Clip art on Office Online will 
be added to your Clip 
Organizer and will be placed 
in your collection of clips. 
When you have finished, the 
bike clips are downloaded to 
the Transportation or Sports 
folder under My Collections. 

Exercise 2.5 

1. Click Clip art on Office Online. 

2. If a window appears asking if you agree to the use of the clip art you are about to see online, 

click Accept. 

FIGURE 2-9 

Microsoft Office Online 

FIGURE 2-10 

Microsoft Office Clips 
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3. In the In the Office Online 

Clip Art and Media dialog 

box, click the down arrow 

beside Search and choose 

Clip Art. key bikes in the 
text box and click Go. 

4. Look through as many 

pages as you wish. Click on 

the arrows to move forward 

or backward through the 

pages of images. 

5. Click in the checkbox below 

any desired images so a 

checkmark appears. (The 

image in Figure 2-1 is on 

page 20. You may choose 

it, if you wish.) 

6. Click Download # Item(s) 
on the blue bar above the clip images. The dialog box 

in Figure 2-11 will be displayed. 

7. In the next windows, click the Download Now button. 
In the Opening ClipArt Dialog Box (Figure 2-12) with 

Open with Clip Organizer chosen, click OK. 

8. Minimize the Explorer. Notice the images that are now 

in one or more subfolders under the Downloaded 

Clips folder. Drag one of the images anywhere onto 

the document page. 

Modifying a Clip Art Frame 

You can move, size, and delete clip art frames the same way you did text and picture 
frames. First you must select the frame. Then resize it by moving your mouse pointer over a 
handle until you see the word Resize. Hold down your left mouse button and drag out or in. 
You can move it by pointing to any border of the clip art frame until you see an icon labeled 
Move along with four arrows. Hold down the left mouse button and move the object around on 
the document page or onto the scratch area for use later. To delete a clip art object, select it and 
press the Delete key. 

You are going to delete all but one clip art frame and use the remaining frame as part of 
your flyer. You will keep the one you think would be a good graphic for a flyer about bike 
helmets. 

Flipping or Rotating the Graphic 

When adding a graphic to a flyer, make sure that it is facing into the publication. This 
leads the reader’s eye onto the information in the publication, not away from it. Depending on 
what graphic you select, you may need to flip it horizontally to face the other direction or you 

FIGURE 2-11 

Download Window 

FIGURE 2-12 

Opening ClipArt Dialog Box 
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may need to rotate it so it is turned on its side or is upside down. Both of these changes to 
images are done using the Rotate or Flip feature in the Arrange menu. The choices you have 
from this menu are shown in Figure 2-13.  

� Free Rotate—Use the Rotate tool to turn the object 
clockwise or counter clockwise by the desired 
amount. 

� Rotate Left—Turn the object to the left 90 degrees 
per click. 

� Rotate Right—Turn the object to the right 90 
degrees per click. 

� Flip Horizontal—Make a mirror image of the object 
on the horizontal axis. 

� Flip Vertical—Make a mirror image of the object on 
the vertical axis. 

Exercise 2.6 

1. Select and delete all but one clip art frame by clicking 

on a clip art frame and pressing Delete.  (Your clip art 
does not have to be the same as the one in Figure 2-

14.) 

2. From the Arrange menu, choose Layout Guides. 

3. Change all four margins to 0.5”. 

4. If necessary, flip the graphic so that it is facing in towards the 

publication by selecting the object and choosing Flip Horizontal 
from the Rotate or Flip feature in the Arrange menu. 

5. Move the graphic so that it snaps to the left margin guide and 

bottom margin guide in the lower left corner of the document 

page. 

6. Resize the graphic so that it measures approximately 4.5” wide 
and 3.25” tall. (Use the Measurements toolbar to help you or 
watch the Object Size Box in the lower right status bar.) 

7. Save the file as bike helmets xxx (where xxx are your initials). 
Your publication should look something like Figure 2-14 except 

that you may have a different graphic. 
 

Adding Text to the Flyer 

Now you will add the text to the flyer that explains the free offer of bike helmets. You 
will create a text box using the Text Box tool and key and format the text. The box will cover 
part of the graphic, but you will learn how to wrap the text around the graphic. 

FIGURE 2-13 

Rotate or Flip Menu 

FIGURE 2-14 

Publication with Clip Art 
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Changing Character Spacing 

Up to now you have changed the size of text to make it stand out. Another feature in 
Publisher that provides formatting of characters is the Character Spacing feature. It is located in 
the Character Spacing dialog box, which is opened from the Format menu. You want to use this 
feature for only a very small amount of text, such as a headline. Changes in character spacing to 
large amounts of text make the text very hard to read. 

The choices in the Character Spacing dialog box shown in Figure 2-15 include the 
following: 

� Scaling—Changes the size of the letters by shrinking and stretching the letters from 0.1% to 
600% in width without making the letters taller. 

� Tracking—Affects the space between two or more adjoining letters in a block of text. 
There are five tracking options: Normal, Tight, Very Tight, Loose, and Very Loose. You 
can also choose Custom to set your own spacing. 

� Kerning—Affects the space between letter pairs when the 
type size is 14 pt. or greater. You can add space between 
pairs of letters or you can decrease space resulting in 
letters overlapping. 

The same features found in the Character Spacing dialog 
box are available on the bottom half of the Measurements 
toolbar. 

Exercise 2.7 

1. With bike helmets xxx showing in the window, select the 
Text Box tool from the Object bar. Create a text box that 

measures 7.5” wide by 7.0” tall and starts at the upper left 
corner where the left margin guide and top margin guide 

meet. 

2. Choose Center Alignment. Key and format the text as 

shown in Figure 2-16. (Open the Format menu and open 

the Character Spacing dialog box to set the scaling.)  

FREE  (Impact, 72 pt., scaling set to 300%) 

Bike Helmets . . .  (Impact, 60 pt. Bold, scaling set to 100%) 

Bring your child . . .   (and following lines) (Arial, 26 pt. bold) 
(press Enter once more for a blank line) 

Protect your . . .   (Arial, 36 pt. italics) 

3. Resize the text box to fit below the last line of text. Save the file again with the same name. 

Adding Another Text Box 

You do not have to put all your text in one text box. You can have several text boxes on 
one page. Draw and position each box and add the text. 

Exercise 2.8 

1. With bike helmets xxx open in the window, click the Text Box tool from the Object toolbar. 

FIGURE 2-15 

Character Spacing 
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2. Click in the lower right corner of the 

document page and draw a box that 

measures 2.25” wide and 0.75” tall. 
Use the Measurement toolbar to help 

you. 

3. Key the following text and format it with 

Arial, 12 pt. bold, and right alignment: 

  For more information, 

  Contact Debbie or Lily at: 

  Phone: (920) 555-5080 

4. If your box is too small, a box with an 

“A” will appear at the bottom of the 

frame as shown in Figure 2-17. Resize 

the text box so that all the text shows. 

(Sometimes even blank lines created by 

pressing Enter will cause this to 

happen.) 

5. Move the box so that the lower right corner snaps to the lower right 

corner on the document page at the intersection of the right margin 

guide and bottom margin guide. 

6. Save the file and keep it open. 

Using Ruler Guides 

In the next exercise, you are going to add another picture 
frame to the document page. In order to position it in the exact location, you’ll use a very useful 
feature called ruler guides. These guides look like green dotted lines and are used to help 
position objects on the page. To use a ruler guide, point at a gray portion of the horizontal or 
vertical ruler so that you see an adjust icon. Drag the guide to the desired position. When a ruler 
guide is placed on the document page and the Snap to feature is turned on, the ruler guides 
become “sticky” and objects snap to the guides. 

The last step for the flyer is to add the city’s logo. You’ll drag horizontal and vertical ruler 
guides into your document. Then you will line up the new picture along the ruler guides. 

Exercise 2.9 

1. With bike helmets xxx still open in the window, point to the horizontal ruler guide with the 
mouse pointer until you see the adjust icon and a tool tip labeled Create Horizontal Guide. 

2. Drag the guide down to 8.5” on the vertical ruler.  Release the mouse. 

3. Drag a guide from the vertical ruler over to 6.25” on the horizontal ruler. 

4. Click the Picture Frame tool and choose Picture from File. 

5. Draw the frame beginning where the two ruler guides intersect and extending down and 

to the right until the frame is approximately 1.5” wide.  

FIGURE 2-16 

Keyed and Formatted Text 

FIGURE 2-17 

Text Frame Adjustment 
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6. Insert Otter Creek Logo.jpg from your prerecorded 
data files. If necessary, adjust the location of the 

logo so it lines up against both ruler guides. 

7. Your publication should now resemble Figure 2-18. 

Save the publication again as bike helmets xxx 
and print it. Close the file. 

Adding WordArt to a Publication 

Up to this point, you have been using the text 
box to create text for headlines and titles. While you 
can vary the font design and size, you are somewhat 
limited in the formatting of the text. WordArt is a 
utility that makes text look like a graphic.  

WordArt is used primarily for headlines, banners, 
and titles. WordArt uses the same fonts as those used 
in a text box but contains special effects that make the 
fonts appear different and graphic-like. Halloween 
Extravaganza in Figure 2-19 illustrates an example of 
WordArt. 

Creating WordArt Frames 

To create a WordArt frame, select the Insert WordArt button on the Object toolbar. When 
you release the mouse button, a grid of style choices appears in a window titled WordArt 
Gallery. From this gallery you may choose the orientation (vertical or horizontal), shape, color, 
and style of the WordArt object (see Figure 2-20). 
Your design choices can be altered later using the 
WordArt toolbar. 

After making a choice from the WordArt 
Gallery, a small dialog box appears instructing 
you to enter Your Text Here. In addition to 
keying text in the Your Text Here dialog box, you can 
select the font design and size. You can also insert 
special characters in the text, such as a trademark or 
copyright symbol. Publisher will autofit the text into 
the frame. 

Once the text has been entered and the font 
design and size have been chosen, click OK or click 
the X in the dialog box to close it. At that point the 
WordArt frame will appear in the document page and 
a new WordArt toolbar will appear (see Figure 2-21). 
You can change the shape, the direction of the text, the 
text wrapping (how the other frames form their shape 
around the WordArt frame), the alignment and 
character spacing, the line thickness of the text and its 
color, or turn on shading or a shadow. All of these 
special effects are easy to use. 

FIGURE 2-18 

Completed Bike Helmet Flyer 

FIGURE 2-19 

Completed Halloween Project 
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Exercise 2.10 

1. Open the File menu and choose New. Begin 
with a new blank page, choosing the Letter 

(portrait) 8.5 x 11” size page. Change all four 

margins to 0.3” in the Layout Guides dialog 
box. 

2. Choose the Insert WordArt tool and choose 
the third shape in the first row.  

3. Key the text: Halloween Extravaganza 

4. Choose the font Chiller, font size 36. Click 
OK. 

5. With the WordArt chosen, choose WordArt 
Shape from the WordArt toolbar. Choose the 
fourth shape in the fourth row. It is labeled Deflate Bottom. 

6. Resize the object by dragging the bottom left handle down and to the left until the object 

measures 5.325” wide and 3.65” tall. 

7. Move the WordArt object to the upper left corner so that the frame is at the top of the paper and 

snaps to the left margin guides.  (It is okay that the frame is outside the margin guide as long as 

none of the contents extend beyond the no-print zone of your printer. Most laser printers have a 

no-print zone of 0.25”. Check with your instructor to find out what the no-print zone is on the 

printer you are using.) 

8. With the WordArt object still selected, click the WordArt shape button and choose Cascade Up. 

9. From the WordArt toolbar, click Format WordArt. Choose the Colors and Lines tab, and 
change the Fill color to gray or silver. Click OK and close the WordArt toolbar. 

10. Save your publication as Halloween xxx (where xxx are your initials). Save often! Keep it open 
for the next exercise. 

FIGURE 2-20 

WordArt Gallery 

FIGURE 2-21 

WordArt Toolbar 
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Layering and Grouping Objects 

A common design technique is layering objects. This means 
one object is on top of one or more objects. This is typically done 
with graphics and WordArt. When two or more objects are 
layered, a decision has to be made as to which object is on top. 
You may have numerous layers, one for each object, and you get 
to control the order of the layers. 

To send an object to the front or back, select the object to be 
layered and choose Order from the Arrange menu or click the down 
arrow next to the Bring to Front button on the Standard toolbar. The 
choices are illustrated in Figure 2-22. The first two choices will 
bring an object to the front of all the layers or send an object to the 
back of all the objects. The Bring Forward and Send Backward 
options will move the object forward and backward only one layer 
at a time. 

Once the objects are layered as desired, they can be grouped 
using the Group feature. Grouping locks objects together to ensure 
that they can be moved and sized together. All the objects that are to be 
grouped need to be selected first. Do this by selecting one object and 
holding the Shift key as you select the other objects.  

When more than one object is selected, a Group Object button 
automatically appears in the lower left corner of the selected objects as 
shown in Figure 2-23. Clicking on this button will group the objects. 
When objects are grouped and selected, only be one set of handles will 
be surrounding the grouped objects and an ungroup icon will appear at 
the bottom right corner of the grouped object (see Figure 2-24). Clicking 
this icon will ungroup the objects. If one of the grouped objects needs to 
be edited, the group needs to be ungrouped first so the individual object 
can be selected and edited. 

You are going to add a graphic to the publication and group it with the WordArt object. 

Exercise 2.11 

1. With Halloween xxx open in the window, use the Clip Organizer Frame tool to open the Clip 
Organizer. Key Halloween in the Search text box and click Search. 

2. Locate a picture with a black cat and drag it onto the document page. If necessary, flip it 

horizontally so that the cat is looking into the page. 

3. Resize the clip art to approximately 3.725” wide and 5” tall. 

4. Move it to 0.725” on the vertical ruler and snap it to the left margin guide. 

5. With the clip art frame still selected, open the Arrange menu and choose Order. Choose Send 
to Back so that it goes behind the WordArt object.  

����Tip:  Use the Measure-
ment toolbar to achieve a 
specific size or location for an 
object. 

FIGURE 2-22 

Bring to Front Button 

 

FIGURE 2-23 

Group Objects Icon 

FIGURE 2-24 

Ungroup Objects Icon 
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6. With the clip art frame still selected, hold the Shift key and click the WordArt frame. A Group 
Objects button will appear as shown in Figure 2-25. 

7. Click the Group Object icon. The two objects are now grouped 
and an Ungroup Object button appears. 

8. Save the file again with the same name.  

Changing a Bullet Symbol 

You are going to add two text box. One will contain 
a bullet list. In Lesson 1, you added bullets to two lines in 
the Bus Ad exercise by clicking the Bullet button on the 
Formatting toolbar. In this next exercise you will add 
bullets but will also change the bullet symbol to more 
appropriately fit the theme. 

Changing the bullet format is done in the Bullets 
and Numbering dialog box (Figure 2-26) chosen from the 
Format menu. You have a choice of formatting normal 
(no bullets), Bulleted list, and Numbered list. When the 
Bulleted list is selected, the New Bullet button appears. 
This opens a grid of symbols that are available in 
different font sets.  

Exercise 2.12 

1. With Halloween xxx showing in your window, create a 
text box that measures 4.85” wide and 2.875” tall. Add the following text and format as shown in 
parenthesis. All the lines are center aligned. 

Otter Creek Zoo (Berlin Sans FB Demi, 48 pt., orange 
font color) 

Children’s Halloween Party (Berlin Sans FB Demi, 28 
pt., orange font color) 

Saturday, October 27, 2007 (Berlin Sans FB Demi, 24 
pt., black font color) 

6 to 10 p.m. (Berlin Sans FB Demi, 24 pt., black font 
color) 

Sunday, October 28, 2007 (Berlin Sans FB Demi, 24 pt., 
black font color)  

1 to 5 p.m. (Berlin Sans FB Demi, 24 pt., black font color) 

2. Move the text box to align at the right margin guide and 3” 
on the vertical ruler. 

3. If the grouped object is covering up the text box, bring the text box to the front. You can also 

right align any of the text that does not show because of the clip art. 

FIGURE 2-25 

Two Objects Selected 

FIGURE 2-26 

Bullets and Numbering Dialog Box 

����Tip:  If you need to edit an 
object that is layered at the 
bottom, send the objects on 
top to the bottom until the 
desired object is on top. 



40 Microsoft Publisher 2007 

4. Create another text box that measures 5.6” wide and 4.575” tall. Add the following text and 
format as shown in parenthesis. Align the box at 1.5” on the horizontal ruler and 6” on the 
vertical ruler. Choose center alignment and format all lines with Berlin Sans FB Demi. 

Pumpkin Carving (26 pt., orange font color) 

Halloween Costume Contest (26 pt., orange font color) 

Graveyard Scavenger Hunt (26 pt., orange font color) 

Bob for Eyeballs (26 pt., orange font color) 

Scary Face Painting (26 pt., orange font color) 

Much More  (26 pt., orange font color) 

5. Leave a blank line and change to right alignment. 

Admission Cost per Day: (18 pt., black font color) 

50¢ for children under 12 (18 pt., black font color) (For the ¢ sign, open the Insert menu and 
choose Symbol. Scroll to below the lowercase letters and click the ¢ symbol. Click Insert and 
then Close.)  

$1.00 for adults (18 pt., black font color) 

6. Leave a blank line and add the final two lines. 

Sponsored by Otter Creek Department of Parks (Berlin Sans FB Demi, 14 pt., orange font 
color) 

And local civic groups (Berlin Sans FB Demi, 14 pt., orange font color) 

7. Select the six lines at the top of the text box. Click the Bullet button. 

8. From the Format menu, choose Bullets and Numbering. Click the Bullets tab, select any 
bullet style, and then click the Character button. 

9. From the Font drop-down list, choose Webdings and choose a symbol that looks like 
Halloween.  Adjust the size of the bullet, if you wish. Click OK twice. 

Changing the Text Wrap for Picture and Clip Art Frames 

When picture and/or clip art frames are added to a publication that 
contains text boxes, the design may need the text to wrap around the picture 
or through the picture or stop above the picture and continue below the 
picture. This is called text wrap. These wrap choices are available in the Text 
Wrap feature chosen from the Picture toolbar (see Figure 2-27). 
 

Exercise 2.13 

1. Insert three more clip art objects that go well with the design. Look at Figure 

2-19 for ideas. 

2. The clip art frame in the upper-right corner should measure approximately 

2.5” square and it should have a square text wrap. 

FIGURE 2-27 

Text Wrap Options 
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3. The clip art frame in the lower right corner should measure approximately 2.5” wide and 2” tall. 
It should have square text wrap. This will push the right-aligned text in toward the center of the 

text box. This is intentional. 

4. The little graphic to the left of the bulleted items should measure approximately 2” wide and 1.1” 
tall. The text wrap for this text box is set at None so that it can be placed very close to the text 

without rearranging the text lines. You may need to send this new clip art frame to the back. 

5. Save your publication again as Halloween xxx. Print it and close it. Your completed flyer should 
be similar to Figure 2-19 when you are finished. 

Summary 
In this lesson, you learned the following: 

� You can search for clip art using the Clip Organizer. 

� You can search for clip art using the Microsoft Clip Gallery 
Live. 

� Flipping clip art turns the direction the picture is facing. 

� Moving and resizing a clip art frame uses the same procedure as for a text box. 

� You can make text look larger and change the space between characters using Character 
Spacing. 

� Ruler guides help you position a frame in an exact location. 

� WordArt makes text stand out and is good for headlines and titles. 

� Bullet symbols can be changed from the default setting and can add greatly to the design of 
the flyer. 

� Objects can be layered and grouped to create a graphic object that can be moved and sized 
as one object. 

�  The text wrap feature determines how close text in a text box can be to a Picture, clip art, 
and WordArt frames. 

L E S S ON  2  R E V I EW  QU E S T I O N S  

TRUE/FALSE 

Circle T if the statement is true or F if the statement is false. 

T F 1. When you draw a picture frame, Publisher takes you directly to the Clip Organizer. 

T F 2. The Flip Horizontal commands turns a Clip Organizer frame 90 degrees. 

T F 3. Deleting a picture from the Clip Organizer does not delete it from your computer system. 

T F 4. Clips downloaded from the Clip art on Office Online are stored in the Downloaded Clips 

folder in My Collections. 

T F 5. To use a ruler guide, you must hold down the Ctrl key and point at the horizontal ruler or 

vertical ruler so that you see an adjust icon. 

����Tip:  When text wrap is set 
to None, you can move an 
object very close to a text box 
frame. One way to do this is 
to use the arrow keys on your 
keyboard to “nudge” an ob-
ject one pixel at a time. 
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T F 6. The WordArt feature can make text look like a graphic. 

T F 7. Individual objects can be edited in a grouped object. 

T F 8. The only two options for moving an object in front of or behind another object are Bring to 

Front and Send to Back. 

T F 9. Find Similar Style options for clip art brings up images created in the same style that 

match the keywords. 

T F 10. Kerning changes the size of the letters by shrinking or stretching the letters. 

FILL IN THE BLANKS 

Complete the following sentences by writing the correct word or words in the blank provided. 

1. When you choose Insert, Picture, you can retrieve graphics images from ______________ 
and from ___________________. 

2. The star icon in the lower right corner of a clip in the Clip Organizer indicates that the clip 
is a(n) _________________. 

3. The feature in the Character Spacing dialog box that adjusts the spacing between a pair of 
letters is _______________. 

4. You must be connected to the _________________________ to use the Clip Art on Office 
on Line. 

5. The Flip feature makes a __________________ image of the object when it is flipped. 

6. The various designs from which to choose for WordArt can be selected from the 
______________________________. 

7. The feature that determines how close a picture, clip art, or WordArt object can be 
positioned near a text box is called ________________________. 

8. To change the bullet symbol to a heart, you would have to select the text, choose 
_________________ from the Format menu, and click the __________________ button. 

9. To tell Publisher what kind of clip art image you’d like, you must key a descriptive word for 
the desired clip art in the _________________________ box. 

10. The Clip Organizer sorts media into five types. Any two of those types are 
_________________________ and _________________________. 

PROJECT 2-1 

You have been asked to create a flyer for the Senior Prom, a special night the Otter Creek 
High School Honor Society is going to conduct for senior citizens at the Otter Creek Seniors 
Center called the Senior Prom. This flyer will be posted at the Seniors Center. 

1. Create a blank document measuring 8½ by 11 inches. 

2. Set the margins at 0.5 inch each in the Layout Guides dialog box. 
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3. Search for a clip art using dancers as your keyword. Choose an appropriate clip art for 
the occasion. 

4. Size the clip to approximately 2.5” x 2.5”. Snap it to the left and top margin guides in 
the upper left corner. 

5. Create a text box to the right of the clip art that extends to the right margin guide and is 
2.5” tall. 

6. Key the words Senior Prom and format the text as follows:  Broadway, 72 pt., bold, 
center alignment, scaling at 140%. If you don’t have Broadway, choose another 
decorative font that will fit the occasion. 

7. Bring down a ruler guide from the horizontal ruler to 3½” on the vertical ruler. 

8. Create another text box starting at the ruler guide that measures 7.5” wide and 
approximately 4.75” tall. Set center alignment. 

9. The prom will be from 7 to 9 p.m. on the second Friday in May. Key the date and time 
on two separate lines and format with Arial, 48 pt. bold. Key the following lines below 
the time: 

Otter Creek Seniors Center (Arial 36 pt. bold) 

Dance to the music of the (Arial, 32 pt.) 

Melo Tones (Arial, 32 pt. bold, italic, and 150% scaling) 

Refreshments (Arial, 32 pt.) 

Cost: $1 at the door (Arial, 32 pt.) 

10. Create another text box that measures 5.0” 
wide and 1.5” tall and position it at the 
lower left corner where the left margin 
guide and bottom margin guide intersect. 

11. Key the following lines and format with 
Arial, 18 pt. bold, and left alignment: 

 Sponsored by: 

 Otter Creek High School Honor Society  

 and 

 The Otter Creek Seniors Center 

12. Create a clip organizer frame in the lower 
right corner that measures approximately 
2.0” wide and 2.0” tall. 

13. Search for a clip art using music as your 
keyword. Choose an appropriate clip art for 
the occasion. 

14. Save your publication as Senior Prom xxx 
where xxx are your initials. Print it and 
close it. Your finished project should look 
something like Figure 2-28. 

FIGURE 2-28 

Completed Project 2-1 
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PROJECT 2-2 

The Otter Creek High School senior class has been asked to help with a yearly popular 
family activity in Otter Creek called the Quarry Quest, where families can visit the local quarry 
to learn about quarry activities and look at the equipment. You have been asked to create the 
flyer that will be posted at the various public places, including the schools.  

You need to include certain text but how you design it is up to you. The flyer in Figure 2-
29 is just an example of what you can do.  

HINT: To get a clip art frame close to the WordArt and text boxes, turn the text wrap to 
None. Also, the large capital letter in the paragraph containing the description is a separate 
WordArt frame with the text wrap also turned to None. One last hint, the top two lines are 
separate WordArt frames and the Quarry Quest WordArt frame is filled with a texture called 
Granite, which is found in Fill Effects under the Color drop-down list in the Fill dialog box. 

Save the file as Quarry Quest xxx 
where xxx are your initials. 

 
 

FIGURE 2-29 

Completed Project 2-2 


